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About this Guide

The quick reference guide combines all of the available options for following payment
methods:

> Credit
> Debit

While not all of these payment methods will be used, the guide shows the functionality
available.

This guide will outline the standard steps (listed in NAVY BLUE) of the terminal as well as
optional steps (listed in light blue), that are available depending on the terminal program. If
the options in light blue do not appear, skip step and go on to the next step. Payment
methods in light blue are optional and may not appear on all terminal programs.

This guide will also differentiate between standard terminal operations listed in ((lglliy from
additional terminal operations listed in \{3XKe}"Y.
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Sales

Credit Sale Omni 3200

Action | Display

(DATE & TIME)

Press F2 for Sale i Swipe Card Acct:
Swipe Card Credit = F1 Debit =F2 EBT = F3
Choose F1 for Credit Invoice No.:

Enter Amount of the tax and/or press the Green ! Connect, Approved Receipt Prints - Print
Key to bypass Customer Copy F1 = No; F2 =Yes

| (Customer Copy Prints)
Press F2 for Yes ! (DATE & TIME)
. F2 = Sale; F3 = Check; F4 = Settlement
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Debit Sale Omni 3200
Action | Display

(DATE & TIME)

F2 = Sale; F3 = Check; F4 = Settlement
Press F2 for Sale ! Swipe Card Acct:
Swipe Card ! Credit = F1 Debit = F2 EBT = F3
Choose F2 for Debit Invoice No.:

...............................................................................................................

Key
Enter Server/Clerk ID and press the Green Key Amount: $
Enter Amount of the sale and press the Green

Cash: $
Key
Enter Amount of cashback you which to receive Tip: $

and press the Green Key

Enter Amount of the tip and/or press the Green
Key to bypass

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Enter Amount of the tax and/or press the Green
Key to bypass

Enter Pin Number on Pinpad and Press the 1 Connect, Approved Receipt Prints - Print
Green Key. i Customer Copy F1 = No; F2 = Yes

i (Customer Copy Prints)
Press F2 for Yes ' (DATE & TIME)
! F2 = Sale; F3 = Check; F4 = Settlement
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Credit Keyed (Manual) Sale Omni 3200
Action | Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press the (SCROLL) Key 2 times and F3 for
Phone/Web

....................................................... NN N A W M M A W e W M oA W W M A o M A W A W oA e e

Type in Card Number and Press the Green Enter Exp Date (MMYY):

Account #:

...............................................................................................................

Enter Last 3 digits on back of the card and Press
Green Enter Key

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter House Number where cardholder bill goes
to, and press Green Enter Key

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Enter Zip Code where cardholder bill goes to,
and press Green Enter Key

Enter Amount of the tax and/or press the Green | Connect, Approved Receipt Prints - Print
Key to bypass i Customer Copy F1 = No; F2 = Yes

i (Customer Copy Prints)
Press F2 for Yes ' (DATE & TIME)
! F2 = Sale; F3 = Check; F4 = Settlement
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Credit Auth Only Omni 3200
Action | Display

Sale; F3 = Check; F4 = Settlement
Press the (SCROLL) Key 1 time and press F4 for
Auth Only

....................................................... o NN N A W M M oA W e W M oA W W M A A W A W WA e e

Swipe Card or Type in Card Number and Press ! Credit = F1 Debit = F2 EBT = F3
the Green Enter Key. '

! Swipe Card Acct:

...............................................................................................................

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter Amount of the sale and press Green Enter | Connect, Approved Receipt Prints - Print

Key Customer Copy F1 = No; F2 =Yes
! (Customer Copy Prints) (DATE &
Press F2 for Yes i TIME) F2 =Sale; F3 =

. Check; F4 = Settlement

Settlement

Settlement Omni 3200

Action | Display

(DATE & TIME) F2=
Sale; F3 = Check; F4 = Settlement

© Shows Sales Summary, Refund Summary and
' Total Settlement Amount — Enter to confirm

Connect, Approved Report Prints, Report should
1 say GB XXX

Press F4 for Settlement

Press Green Enter Key to Settle
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Voids/Refunds

Credit Refund Omni 3200
Action Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press the (SCROLL) Key 1 time and press F3 for
Refund

Swipe Card or Type in Card Account Number and |
Press the Green Enter Key. '

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter Amount of the refund and press Green i Connect, Approved Receipt Prints - Print
Enter Key I Customer Copy F1 = No; F2 = Yes

_______________________________________________________________________________________________________________

i (Customer Copy Prints)
Press F2 for Yes ! (DATE & TIME)
| F2 = Sale; F3 = Check; F4 = Settlement
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Credit Void Omni 3200

Action | Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

5;(2:5 the (SCROLL) Key 1 time and press F1 for ' Void Last Trans? F1=No F2=Yes

....................................................... NN N A W M M A W e W M oA W W M A o M A W A W oA e e

If Yes: Transaction Displays: F1=No F2=Yes F3=Next

Choose F2=Yes to Void Transaction; F1 cancels
transaction; F3 has no meaning here.

Choose F2=Yes to Void Transaction; F1 cancels
transaction; F3 = Next
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Offline/Forced Sales

Credit Offline Omni 3200

Action | Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press the (SCROLL) Key 1 time and press F2 for
Offline

Swipe Card or Type in Card Account Number and |
Press the Green Enter Key.

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

_______________________________________________________________________________________________________________

Enter Invoice Number (6 digits) and press Green
Enter Key

! Connect, Approved Receipt Prints - Print
i Customer Copy F1 =No; F2 =Yes

| (Customer Copy Prints)
Press F2 for Yes ! (DATE & TIME)
i F2 = Sale; F3 = Check; F4 = Settlement
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Debit Re-Enter Omni 3200
Action i Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press the (SCROLL) Key 1 time and press F2 for
Offline

....................................................... o NN N A W M M oA W e W M oA W W M A A W A W WA e e

Swipe Card or Type in Card Account Number and ! Credit = F1 Debit = F2 EBT = F3
Press the Green Enter Key. '

! Swipe Card Acct:

...............................................................................................................

Enter Original Date of the transaction
(MMDDYY) and press Green Enter Key

Enter Original time of the transaction (HHMMSS)
and press Green Enter Key |

Enter Network ID (3 digits) and press Green
Enter Key

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Enter Settlement Date (MMDD) and press Green |
Enter Key !

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter Amount of the sale and press Green Enter Connect, Approved Receipt Prints - Print
Key i Customer Copy F1 = No; F2 = Yes

i (Customer Copy Prints)
Press F2 for Yes ' (DATE & TIME)
' F2 = Sale; F3 = Check; F4 = Settlement
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Reports

Totals Report Omni 3200

Action ! Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

| F1=Totals Report; F2 = Detail Report; F3 =
1 Server Reports; F4 = Shift Reports

Press Report

Press F2 for Totals Report Report will Print

Detail Report Omni 3200

Action ! Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

! F1 = Totals Report; F2 = Detail Report; F3 =
. Server Reports; F4 = Shift Reports

Press Report

Press F3 for Detail Report ! Report will Print

Server Report Omni 3200

Action 5 Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

! F1 = Totals Report; F2 = Detail Report; F3 =
. Server Reports; F4 = Shift Reports

| F1 = Totals Report; F2 = Detail Report; F3 =
Press ¥ (MORE KEY) 1 time and press F1 for Unadjust Report F4 = Server Table; ¥ (MORE
Server Report i KEY) 1 time F1 = IRS Tip Report; ¥ (MORE KEY) 1
' time F2 Discount Tip

If h i hoose F2; If !
o woutd e ol of the patches i momary | IFF2)= Reprnt Batch Rpt - ettloment Date: /
’ y i (If F3) = Report will print

choose F3

Enter in the Date of the settlement (MMDDYY)
and press Green Enter Key

Press Report

' Report will Print
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Unadjust Report Report Omni 3200
| Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

F1 = Totals Report; F2 = Detail Report; F3 =
i Server Reports; F4 = Shift Reports

F1 Totals Report; F2 = Detail Report; F3 =
. Unadjust Report F4 = Server Table; ¥ (MORE
i KEY) 1 time F1 = IRS Tip Report; ¥ (MORE KEY) 1
________________________________________________________ | timeF2DiscountTip
Choose from any of these reports F2 = Totals
Report; F3 = Detail Report; F4 = Server Table; V¥
1 time F1 = IRS Tip Report; V¥ 1 time F2 Discount

Tip

Batch History Report Report Omni 3200

Action ; Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

E F1 = Totals Report; F2 = Detail Report; F3 =
! Server Reports; F4 = Shift Reports

Press ¥ (MORE KEY) 1 time and press F1 for
Batch History Report

Press Report

| Report will Print

Press Report

Press F3 for Unadjust Report ' Report will Print

Reprint Receipt Omni 3200

Action ; Display

(DATE & TIME)
F2 Sale; F3 = Check; F4 = Settlement

Press Reprint

If Last Receipt press F1

Enter Invoice Number and press the Green Enter
Key
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Tip Adjust by Server Omni 3200

Action | Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press Adjust ! F1 = Clrk/Srvr; F2= Amt; F3 = Acct; F4 = Inv#t
Choose F1 for Srvr Server ID:
Enter Server ID and press the Green Enter Key Shows Transaction F1 = Adj; F2 = Next;

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

To scroll to the next transaction hit F2 for NEXT, Current Tip Amount shows; asks for the new tip
to adjust hit F1 : amount

Enter Amount of the tip and the Green Enter Key Total....Processing... Approved...Receipt Prints.

Tip Adjust by Amount Omni 3200

Action | Display
(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement
Press Adjust ! F1 = Clrk/Srvr; F2= Amt; F3 = Acct; F4 = Inv#
Choose F2 for Srvr Amount: $ 0.00

Enter Amount of the sale and press the Green | Shows Transaction F1 = Adj; F2 = Next;
Enter Key '

....................................................... o e M oA W M N oM A W e oM oA W W W M A o M A W A W oA W e

To scroll to the next transaction hit F2 for NEXT, Current Tip Amount shows; asks for the new tip
to adjust hit F1 i amount

Enter Amount of the tip and the Green Enter Key Total....Processing... Approved...Receipt Prints.
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Tip Adjust by Account Omni 3200
Action | Display

(DATE & TIME)

F2 = Sale; F3 = Check; F4 = Settlement
Press Adjust ' F1 = Clrk/Srvr; F2= Amt; F3 = Acct; F4 = Inv#
Choose F3 for Account Last 4 digits:

Enter last 4 digits of the card number and press
the Green Enter Key

...............................................................................................................

To scroll to the next transaction hit F2 for NEXT, | Current Tip Amount shows; asks for the new tip
to adjust hit F1 | amount

| Shows Transaction F1 = Adj; F2 = Next;

Tip Adjust by Invoice Omni 3200
Action | Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press Adjust ' F1 = Clrk/Srvr; F2= Amt; F3 = Acct; F4 = Inv#

Enter invoice number on receipt and press the
Green Enter Key

_______________________________________________________________________________________________________________

To scroll to the next transaction hit F2 for NEXT, | Current Tip Amount shows; asks for the new tip
to adjust hit F1 i amount

Enter Amount of the tip and the Green Enter Key Total....Processing... Approved...Receipt Prints.
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Tabs (Restaurant Only)

Open Tab Omni 3200

Action : Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Tab - F1 = Open Tab; F2 = Close Tab; F3 = Del
Tab; F4 = Tab Rpt

_______________________________________________________________________________________________________________

Press ¥ 2 times and press F4 for Tab

Choose F2 for Open Tab ' Swipe Card Acct:
Swipe Card or Type in Card Account Number the ! Credit = F1 Debit = F2 EBT = F3
GREEN Enter key. !

Choose F1 for Credit | Exp Date (MMYY):

....................................................... e mmmmmmmsmsmsmmmsssssmmsssssmmssmsssssssmssss===========

Enter Expiration Date and press Green Enter Key ' Imprint Card - Press Enter Key

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter Amount of the Tab and press Green Enter

| , A Receipt Prints - Pri
Key or to remain at default amount Press Green | Connect, Approved Receipt Prints - Print
' Customer Copy F1 = No; F2 = Yes
Enter Key i

i (Customer Copy Prints)
Press F2 for Yes ! (DATE & TIME)
' F2= Sale; F3 = Check; F4 = Settlement
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Close Tab Omni 3200
| Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

| Tab - F1 = Open Tab; F2 = Close Tab; F3 = Del
i Tab; F4 = Tab Rpt

....................................................... o N A A W R M oA e W M oA W W M A A W A WA e e

Choose F2 for Close Tab Close Tab - Retrieve By: F1 = Inv#; F2 = Acct#

Press V¥ 2 times and press F4 for Tab

Choose F1 if by Invoice Number ! Invoice Number:
Enter Invoice Number (6 digits) and press Green
Enter Key

To scroll to the next transaction hit F3 for NEXT,
to close tab hit F1

Choose F1 for Yes Server ID:
Enter Server ID and press Green Enter Key ﬁr:v:l;\nr:t: $ (()(()):)xg)
Enter in the amount of the Tab at time of close Tip S 0.00

Enter Amount of the tip and press Green Enter

' C t, A d Receipt Print
Key ! onnec pprove ecelp rints

Choose F2 if by Account Number ! Last 4 digits:
Enter last 4 digits of the card number and press
the Green Enter Key

To scroll to the next transaction hit F3 for NEXT,
to close tab hit F1

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Choose F1 for Yes Server ID:
Enter Server ID and press Green Enter Key :r:v:inr:t: $ (()(()'.):)xg)
Enter in the amount of the Tab at time of close Tip S 0.00
| Enter Amount of the tip and press Green Enter | Connect, Approved Receipt Prints - Print
W o T CRETE R S e s
Press F1 for Yes i Customer Copy Prints
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Delete Tab Omni 3200
Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

| Tab - F1 = Open Tab; F2 = Close Tab; F3 = Del
i Tab; F4 = Tab Rpt

....................................................... o N A A W R M oA e W M oA W W M A A W A WA e e

Choose F3 for Del Tab Close Tab - Retrieve By: F1 = Inv#; F2 = Acct#

Press V¥ 2 times and press F4 for Tab

Choose F1 if by Invoice Number Invoice Number:

Enter Invoice Number (6 digits) and press Green

Enter Key

To scroll to the next transaction hit F3 for NEXT,

to close tab hit F1 5 721D PIBIEEE
Choose F2 if by Account Number Last 4 digits:

Enter last 4 digits of the card number and press
the Green Enter Key

To scroll to the next transaction hit F3 for NEXT,
to close tab hit F1

Tab Report Omni 3200

Action | Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

' Tab - F1 = Open Tab; F2 = Close Tab; F3 = Del
! Tab; F4 = Tab Rpt

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

' Tab Deleted

Press ¥ 2 times and press F4 for Tab

Press F4 for Tab Rpt ! Report will print
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Add Server Omni 3200

Action | Display
(DATE & TIME)

CONFIGURE SERVER - F1 = Log On Server; F2 =
Log Off Server; F3 = Add Server; F4 = Modify
Server; VF1 = Delete Server; YF2 =Cir All

Press (SCROLL KEY) until screen displays Server
Setup - Press the F Key for Server Setup

Green Enter Key

. Servers .
Press F3 for Add Servers ! Add Servr - Server ID:
Enter Server ID and press Green Enter Key 1 Password:

| To create type in a password (can be specificfor |
managers or the same as the clerk id) and press | Reenter:

i Server Added will flash - Screen will go back to
i Add Servr - Server ID:

...............................................................................................................

Action Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

1 CONFIGURE SERVER - F1 = Log On Server; F2 =
Press (SCROLL KEY) until screen displays Server : Log Off Server; F3 = Add Server; F4 = Modify

Setup - Press the F Key for Server Setup i Server; Y F1 = Delete Server; YF2 =Clr All
o LSEMVers

Press ¥ F1 for Modify Server Mod Servr - Server ID:

Enter Server ID and press Green Enter Key Old Pass:

T T

ype in the old password and press Green Enter New Pass:
Key
Type in new password and press Green Enter Reenter:

Server Modified will flash - Screen will go back
' to Mod Servr - Server ID:

Press Red Clear key 2 times to exit i Terminal will go back to main screen
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Delete Server Omni 3200
Action | Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

i CONFIGURE SERVER - F1 = Log On Server; F2 =
Press (SCROLL KEY) until screen displays Server | Log Off Server; F3 = Add Server; F4 = Modify

Setup - Press the F Key for Server Setup ! Server; VF1 = Delete Server; Y F2 = Clr All
. iServers

Press V¥ F2 for Delete Server Del Servr - Password:

Type in 1, Alpha, Alpha, 6,6,8,3,1 Del Servr - Server ID:

Enter Server ID and press Green Enter Key ! Password:

Server Deleted will flash - Screen will go back to
Del Servr - Server ID:

Action Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

1 CONFIGURE SERVER - F1 = Log On Server; F2 =
Press (SCROLL KEY) until screen displays Server ' Log Off Server; F3 = Add Server; F4 = Modify

Setup - Press the F Key for Server Setup i Server; VY F1 = Delete Server; YF2 =Clr All
o iServers
Press V¥ F3 for Clear Servers Servr Clear - Password:

' Srvr Tlts Deleted will flash on the screen -
| CONFIGURE SERVER - F2 = Log On Server; F3 =

Type in 1, Alpha, Alpha, 6,6,8,3,1 Log Off Server; F4 = Add Server; V F1 = Modify
» Server; VF2 =Delete Server; VY F3 = Clear
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, . Servers
Press Red Clear key 1 time to exit Terminal will go back to main screen
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LogOn Server Omni 3200 (Clrk/Srvr Mode must be

set to LOGON)
Action Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

| CONFIGURE SERVER - F1 = Log On Server; F2 =
Press (SCROLL KEY) until screen displays Server ! Log Off Server; F3 = Add Server; F4 = Modify

Setup - Press the F Key for Server Setup Server; YF1 = Delete Server; YF2 =Cir All
L Servers

Press F2 for Log On Servers Logon - Server ID:

Enter Server ID and press Green Enter Key Password:

i LogOn Successful will flash - Screen will go back

Type in a password and press Green Enter Key ' to Main screen

LogOff Server Omni 3200 (Cirk/Srvr Mode must

be set to LOGON)
Action i Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

i CONFIGURE SERVER - F1 = Log On Server; F2 =
Press (SCROLL KEY) until screen displays Server : Log Off Server; F3 = Add Server; F4 = Modify

Setup - Press the F Key for Server Setup ! Server; VF1 = Delete Server; Y F2 = Clr All
.. iServers

Press F2 for Log On Servers ! Logoff - Server ID:

Enter Server ID and press Green Enter Key i Logoff - Confirm F1 =Yes; F2 = No

LogOff Successful will flash - Screen will go back
to Main screen

Choose F1 for Yes !
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EBT Food Sale Omni 3200

Action | Display

o | SOFTPAY
From Home Menu Choose Credit/Debit ' F2= Sale; F3 = Phone Order: F4 = Check:

_______________________________________________________________________________________________________________

Swipe card or Type in EBT card number and ' Debit = F1; EBT = F2
press Green Enter Key !

_______________________________________________________ S

Choose F2 for EBT EBT - Trans Type - F1 = Vchr; F2 = Food, F3 = Cash

Choose F2 for Food ! Invoice No.:
E | iceN igi i
nter Invoice Number (6 digits) and press Green ' server/Clerk ID:
Enter Key !

Key
Enter Pin Number on Pinpad and Press the ! Connect, Approved Receipt Prints - Print
Green Key. Customer Copy F1 = No; F2 =Yes

| (Customer Copy Prints)
Press F2 for Yes ! (DATE & TIME)
. F2 = Sale; F3 = Check; F4 = Settlement
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EBT Cash Sale Omni 3200 (Swipe Only)
Action Display

| SOFTPAY
' F2 = Sale; F3 = Phone Order; F4 = Check;

_______________________________________________________________________________________________________________

From Home Menu Choose Credit/Debit

Press F2 for Sale Swipe Card Acct:
Swpewrda DoemsrnesTers
[ chooserrtoresr i EBT  Trans Type - FL = Vehr; F2.=Food, F3 = Cash
Gomerstorcsh  meleenos

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter Amount of cashback you which to receive
and press the Green Key

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Enter Pin Number on Pinpad and Press the Connect, Approved Receipt Prints - Print
Green Key. i Customer Copy F1 = No; F2 = Yes

i (Customer Copy Prints)
Press F2 for Yes . (DATE & TIME)
i F2 = Sale; F3 = Check; F4 = Settlement
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EBT Voucher Sale Omni 3200 (Pre

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press F2 for Sale 5 Swipe Card Acct:

Key
Choose F2 for EBT EBT - Trans Type - F1 = Vchr; F2 = Food, F3 = Cash
Choose F1 for Voucher Invoice No.:

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter Voucher Serial Number and press Green
Enter Key

Connect, Approved Receipt Prints - Print
Customer Copy F1 = No; F2 = Yes

(Customer Copy Prints)
(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press F2 for Yes
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EBT Food Re-Enter Omni 3200
Action i Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press the (SCROLL) Key 1 time and press F2 for
Offline

....................................................... o NN N A W M M oA W e W M oA W W M A A W A W WA e e

Swipe Card Acct:

Swipe Card or Type in Card Account Number and Debit = F1; EBT = F2
Press the Green Enter Key.

Choose F2 for EBT EBT - Trans Type - F1 = Food; F2 = Cash, F3 = Vchr
Choose F1 for Food EBT - ReEnter Food Type - F1 = FSale; F2 = FRefn
Choose F1 for FSale Invoice No

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter Network ID (3 digits) and press Green
Enter Key

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Enter Settlement Date (MMDD) and press Green
Enter Key

Enter Original Date of the transaction
(MMDDYY) and press Green Enter Key

Enter Original time of the transaction (HHMMSS)
and press Green Enter Key

Enter Amount of the sale and press Green Enter | Connect, Approved Receipt Prints - Print
Key | Customer Copy F1 = No; F2 =Yes

| (Customer Copy Prints)
Press F2 for Yes ! (DATE & TIME)
i F2 = Sale; F3 = Check; F4 = Settlement
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EBT Cash Re-Enter Omni 3200
Action ; Display

(DATE & TIME)
F2 = Sale; F3 = Check; F4 = Settlement

Press the (SCROLL) Key 1 time and press F2 for
Offline

Swipe Card or Type in Card Account Number and
Press the Green Enter Key.

Enter Invoice Number (6 digits) and press Green
Enter Key

Enter Network ID (3 digits) and press Green
Enter Key

'
....................................................... s M O M oA N M N oM A W e W oM oA W W M A A W W A W oA e

Enter Settlement Date (MMDD) and press Green ' Orig Tran Date:
Enter Key !

Enter Original Date of the transaction
(MMDDYY) and press Green Enter Key

Enter Original time of the transaction (HHMMSS)
and press Green Enter Key

Settlement Date:

Orig Tran Time:

Enter Amount of the sale and press Green Enter | Connect, Approved Receipt Prints - Print
Key Customer Copy F1 = No; F2 = Yes

| (Customer Copy Prints)
Press F2 for Yes ! (DATE & TIME)
. F2 = Sale; F3 = Check; F4 = Settlement
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